Trademarks

The following are trademarks of Motorola: MOTOTRBO™.

Any other brand or product names are trademarks or registered trademarks of their respective holders.

The Genesis Group Trademark Information

GW3-TRBO® is a registered trademark of GenCore Candeo, LTD., a subsidiary of Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks.

Copyright

Copyright © 2006-2020; Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks. All rights are reserved. No part of this publication or the associated program may be reproduced, transmitted, transcribed, in whole or in part, in any form or by any means, whether it is mechanical, magnetic, optical, electronic, manual or otherwise, without the prior written consent of Burks GenCore Co., Inc. D.B.A:
The Genesis Group and Phil Burks
5800 Eagles Nest Blvd
Tyler, Texas 75703.

Includes technology licensed from Motorola.

Disclaimer

The GW3-TRBO User’s Manual is printed in the U.S.A. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks believe that the information included in this manual is correct; however, Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks reserves the right to alter, revise and make periodic changes to the manual and its contents. Burks GenCore Co., Inc. D.B.A. The Genesis Group does not assume responsibility to notify any person of such revisions or changes. While we have taken strides to carefully examine our software and documentation and believe that it is reliable, the Genesis Group and Phil Burks assume no responsibility for the use of the manual, or GW3-TRBO software, nor for any patent infringements or other rights of third parties who may use the manual or the GW3-TRBO software. Burks GenCore Co., Inc. D.B.A. The Genesis Group and Phil Burks make no representations or warranties with respect to the contents or fitness for a particular purpose beyond the cost of the software paid by the end-user.

The software contains valuable trade secrets and proprietary information. Unauthorized use of the manual or software can result in civil damages and criminal prosecution. As an end user, you agree to abide by and heed these statements.

License

Title to the media on which the program is recorded and to the documentation in support of the product is transferred to you, but title to the program, and all subsequent copies of the program, despite the form or media in or on license is not a sale of the original or any subsequent copy. You assume responsibility for the selection of the program to achieve your intended results, and for the installation, use, and results obtained from the program.

Refer to the GW3-TRBO Manual Overview for your full license. All license information contained on pages 4-7 (Book 600-2.16.15-AA.1) are to be considered as contained herein.

Support

Customer satisfaction is our number one priority at Genesis. We are here to provide you with the best software possible, and we want to know when you have any questions, concerns or problems with GW3-TRBO so that we can make it a better product for everyone.

Refer to the Troubleshooting & Support section of the GW3-TRBO Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
**Document History**

<table>
<thead>
<tr>
<th>Revision</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.0.5</td>
<td>Initial Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.5</td>
<td>Replaced GW3-TRBO trademark with registered trademark.</td>
<td>JAW</td>
</tr>
<tr>
<td>2.0.5</td>
<td>Added clarification about [LE] and [RDAC] activity.</td>
<td>REB</td>
</tr>
<tr>
<td>2.0.6.6</td>
<td>Changes before release</td>
<td>WRK</td>
</tr>
<tr>
<td>2.1</td>
<td>Changes before release</td>
<td>KIH</td>
</tr>
<tr>
<td>2.2</td>
<td>Update of Screenshots and Descriptions</td>
<td>CWF</td>
</tr>
<tr>
<td>2.2</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.3</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.4</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.5</td>
<td>Added how to delete packet types from the list.</td>
<td>REB</td>
</tr>
<tr>
<td>2.6</td>
<td>Revisions Before Release</td>
<td>CWF</td>
</tr>
<tr>
<td>2.7</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.8</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.9</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.10</td>
<td>Updated “Ch. #” with satellite receiver information.</td>
<td>REB</td>
</tr>
<tr>
<td>2.11</td>
<td>Converted to Docx format</td>
<td>CWF</td>
</tr>
<tr>
<td>2.12</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.13</td>
<td>Revisions Before Release</td>
<td>ATG</td>
</tr>
<tr>
<td>2.14</td>
<td>Revisions Before Release</td>
<td>JAW</td>
</tr>
<tr>
<td>2.15</td>
<td>Revisions Before Release</td>
<td>REB</td>
</tr>
<tr>
<td>2.16</td>
<td>Revisions Before Release</td>
<td>JPS</td>
</tr>
</tbody>
</table>
# Table of Contents

- Trademarks ........................................................................................................... 3
- The Genesis Group Trademark Information .......................................................... 3
- Copyright .................................................................................................................. 3
- Disclaimer ............................................................................................................... 3
- License .................................................................................................................... 3
- Support ................................................................................................................... 3

**DOCUMENT HISTORY** .......................................................................................... 4

**TABLE OF CONTENTS** ........................................................................................ 5

**ABOUT THIS MANUAL** ......................................................................................... 7
- GOALS ...................................................................................................................... 7
- WHO SHOULD READ THIS MANUAL? ..................................................................... 7
- HOW THIS MANUAL IS ORGANIZED ..................................................................... 7

**CHAPTER 1**  **OVERVIEW** .................................................................................. 9
- WHAT IS ACTIVITY? .................................................................................................. 10
- MONITORING CHANNEL ACTIVITY ...................................................................... 10
  - Activity Values ..................................................................................................... 11
  - Maximizing the Activity List .............................................................................. 12
- CUSTOMIZING CHANNEL ACTIVITY ..................................................................... 12
  - Changing Activity List Font and Size .................................................................. 13
  - Enabling/Disabling the Green Bar ...................................................................... 13
  - Showing/Hiding Columns .................................................................................. 13
  - Reordering Columns .......................................................................................... 14
  - Adding a Little Color to Your Life ....................................................................... 14
  - Filtering Packet Types ...................................................................................... 14
  - Selecting All Packet Types ................................................................................ 15
  - Unselecting All Packet Types .......................................................................... 15
  - Deleting Packet Types ...................................................................................... 15
  - Suppressing Duplicate Packets ......................................................................... 15

**CHAPTER 2**  **ADVANCED OPTIONS** ................................................................. 17
- ADVANCED FILTERS ............................................................................................... 18
  - Trunking Filters .................................................................................................. 18
    - System Filter .................................................................................................... 18
    - Group Filter ..................................................................................................... 19
    - Radio ID Filter .................................................................................................. 20
  - Agencies Filter ................................................................................................... 20
- PAUSING THE ACTIVITY LIST .............................................................................. 21
  - Pause Window Options ...................................................................................... 22
    - Opacity (available in menu only) ...................................................................... 22
    - Print (available in menu and right-click) .......................................................... 22
    - Select All… (available in right-click only) ......................................................... 22
- ACTIVITY DETAILS ............................................................................................... 23
Goals
This document describes the role and function of the Activity module and Activity GUI (Graphical User Interface) within the GW3-TRBO solution.

Who Should Read This Manual?
This document is written for an intended audience of novice to intermediate MOTOTRBO system users and novice to intermediate PC users.

How This Manual Is Organized
This manual is organized as follows:

- Overview: Describes the basic function of the Activity module and GUI.
- Advanced Options: Describes the function of the advanced Activity options.

This manual contains the following images, used to indicate that a segment of text requires special attention:

- **Additional Information**: Additional information is used to indicate shortcuts or tips.
- **Warning**: Warnings are used to indicate possible problem areas, such as a risk of data loss, or incorrect/unexpected functionality.
This chapter defines the Activity module and Activity GUI and gives instructions on filtering and color-coding packets.

This chapter contains the following sections:

- **What is Activity?**: Defines the Activity module and GUI.
- **Monitoring Channel Activity**: Describes how to interpret the data in the activity list.
- **Customizing Channel Activity**: Describes how to customize the Activity GUI.

![Activity GUI](image_url)

**Figure 1.1 – Activity GUI**
**What is Activity?**

The Activity GUI shows real-time activity from each GW3-TRBO input connection. Through this window you can:

- Monitor channel activity.
- Filter the packet types.
- Assign colors to specific packet types.
- Customize the font and column order of the activity list.
- Suppress duplicate packets.
- Pause the activity list.
- Print the activity list.

**Monitoring Channel Activity**

The Activity GUI provides the activity list. This list allows you to view stream activity in real time. For a description of the type of information that can be received for an input type, refer to the module book for the associated input module.

Refer to the *Troubleshooting & Support* section of the GW3-TRBO Manual Shell (Book 600-2.16.15-AA.1) for complete support and contact information.
Activity Values

The activity list contains the following columns:

- **Description**: Broad category of the activity (e.g. Channel Assignment, Call Alert, etc.).
  - Activity that is prefixed with [LE] indicates link establishment data that is sent only over the IP network and is not transmitted over the air. Such data usually is related to creating and maintaining the connection between GW3-TRBO and the other network peers.
  - Activity that is prefixed with [RDAC] indicates communication between GW3-TRBO and an RDAC connection within a repeater. RDAC connections grant access to repeater diagnostic information.
- **Group**: Target group (if any) of the activity.
- **Group Alias**: Alias of the target group (if there is a group). See note on aliases below.
- **ID**: Primary radio ID (if any) of the activity. The primary ID is the source of a call or the radio being affected by a radio command such as an inhibit. For repeater-based activity, this may show the peer ID.
- **ID Alias**: Alias of the primary radio ID (if there is a radio ID). See note on aliases below.
- **Type**: Activity subcategory. Further describes the type of activity.
- **Target ID**: This will contain one of the following values, if the value is provided in the packet:
  - **Target Radio ID**: For call alerts, private calls, etc.
  - **Requester Radio ID**: For radio checks and inhibits.
  - **Diagnostic Condition Description**: For system diagnostics
- **Target ID Alias**: This will contain one of the following values, if the value is provided in the packet:
  - **Target Radio ID Alias**: For call alerts, private calls, etc. See note on aliases below.
  - **Requester Radio ID Alias**: For radio checks, inhibits, etc.
- **Ch. #**: This column will contain the Channel Number that the activity took place on. For IP connections, the Channel Number will generally be the repeater’s Peer ID followed by the slot number (“3-1” to indicate Peer 3, Slot 1). For multisite IP Site Connect calls, this value will show the Site-Channel-Slot combination for all slots on which the call occurred. (For example, “10-1-2, 11-1-2” if the call occurred on slot 2 of sites 10 and 11.) For activities from satellite receivers, this value will show the voting repeater ID followed by the satellite receiver ID. (For example, “15-21” if voting repeater 15 has a satellite receiver with a peer ID of 21.)
- **Ch. Freq.**: This column will contain the frequency of the channel the activity took place on.
- **Ch. Alias**: This column will contain the alias of the channel the activity took place on. For multisite data, this column will be empty. See note on aliases below.
- **Timestamp**: The date and time when the activity was received or originated. This will be the packet time stamp for packets that include a time stamp. Otherwise, it will be the date and time the packet was received by the input module.
- **Elapsed Time**: The duration of the activity. Only Calls and Busies provide an elapsed time.
- **System ID**: The system on which the activity originated.
- **System ID Alias**: The alias of the system on which the activity originated. See note on aliases below.
- **Zone ID**: The zone on which the activity originated.
- **Zone ID Alias**: The alias of the zone on which the activity originated. See note on aliases below.
- **Site ID**: The site on which the activity originated.
- **Site ID Alias**: The alias of the site on which the activity originated. See note on aliases below.

You can view the details of an activity by double-clicking on an entry in the activity list. This will result in a dialog box showing every property that GW3-TRBO knows about the selected activity. This functionality is also available in the **Pause** window.

Aliases (ID, Group, Target Radio ID, Channel, System ID, Zone ID, and Site ID) can be changed in the Alias GUI. If the alias has not been changed it will appear in the appropriate column using the respective GW3-TRBO default GW$[ID], GW$[Group ID], GW$[System ID], etc., format alias.

### Maximizing the Activity List

The Activity GUI allows you to resize the activity list. To resize the activity list, follow the steps below:

1. Hover over the slider bar between the **Packet Types** check list and the activity list. This will show a resize mouse pointer.
2. Hold down the left-click button and move the mouse left and right to resize the activity list.
3. You can also double-click on the slider bar to maximize the activity list and hide the **Packet Types** check list. To show the **Packet Types** check list again, double-click on the slider bar. This can also be done by checking/unchecking the **Packet Types** menu option under the **Filter** menu.

### Customizing Channel Activity

The visual appearance of the data shown in the activity list can be customized in various ways. Features such as the font, font size, columns, column order, packet type colors, and more can be changed. These allow you to customize the look of the data to fit your needs.
Changing Activity List Font and Size
To change the font or size:
1. Click the Font menu option in the View menu. This will display the Font window.
   a. You can also right-click on the activity list and choose the Font menu option from the menu that appears.
2. Choose the Font, Font style (italic, bold, etc.), Font Size, among other options.
3. Click the OK button to apply the changes to the activity list.

![Font Window](image)

Figure 1.2 – Font Window

Enabling/Disabling the Green Bar
Another feature that can be enabled is the Green Bar. When enabled, the background of the rows in the activity list is alternately colored green and white. This allows you to easily distinguish between consecutive packets and not confuse the data on adjacent lines. To enable/disable the Green Bar, either select the Green Bar menu option from the View menu or right-click anywhere on the activity list and select the Green Bar option from the menu that appears.

Notice that the Group and Radio ID columns may not change to the green background color. If a Group or Radio ID’s background color has been changed in the Alias GUI, those colors assigned will be used instead. See the Alias module book for more details on changing foreground and background colors for groups and radio IDs.

Showing/Hiding Columns
To select the visible columns in the activity list:
1. Click the Select Columns menu option under the View menu. This will display the Select Columns window.
   a. You can also right-click on the activity list and choose the Select Columns menu option from the menu that appears.
2. Check the columns you wish to see in the activity list. By default, all columns will be checked and thus will appear in the activity list.
3. Click the **OK** button to apply the changes to the activity list.

![Select Columns Window](image)

**Figure 1.3** – Select Columns Window

**Reordering Columns**

To change the location of a column:
1. Click the column header (column title) of the column you wish to move and hold the mouse button.
2. Drag to the left or right until you have reached the desired position. As the column is being dragged, the column you are currently over will be highlighted.
3. Release the mouse button when you have reached the desired position. The column you dragged will be placed at the position of the currently highlighted column. The highlighted column and all columns to its right will now be to the right of the dragged column. All those to the left will continue to be to the left.

**Adding a Little Color to Your Life**

To assign a color to a packet type, take the following steps:
1. Right-click on the packet type in the **Packet Types** list. This will result in a color dialog box.
2. Select the color that you wish to assign to the packet type.
3. Click **OK**. This will change the color of the selected packet type to the chosen color. All activities of this packet type in the activity list will also change to the selected color.

The Group and Radio ID columns do not change to the selected color. This is because these columns use the colors assigned to them in the Alias GUI. See the Alias module book for more details on changing foreground and background colors for groups and radio IDs.

**Filtering Packet Types**

The Activity GUI contains a **Packet Types** list that shows all known packet types. This list will start off empty and will add new packet types as they are received by
GW3-TRBO. New packet types will default to checked (included) in the Packet Types list. All checked packet types will appear in the activity list as they are received. Packet types that are unchecked will not be shown in the activity list.

![Packet Types](image)

**Figure 1.4** – Two Checked (Included) Packets

**Selecting All Packet Types**
Click the Select All button to select all packet types in the list. This will show all activity for all known packet types.

**Unselecting All Packet Types**
Click the Unselect All button to unselect all packet types in the list. This will exclude all activity for all known packet types, thus stopping the scrolling activity.

**Deleting Packet Types**
Click on a packet type to select it, then press the Delete key to remove that packet type from the list. Holding the Shift key while pressing Delete will remove all packet types from the list. You can also click the Delete and Clear buttons under the Packet Types list.

![Packet Types List Buttons](image)

**Figure 1.5** – Packet Types List Buttons

**Suppressing Duplicate Packets**
This option allows you to filter out consecutive packets with very similar details. To be hidden, a packet must have the same type, ID, target ID, etc., as the previous packet. To enable/disable duplicate packets check/uncheck the Suppress Duplicates menu option in the Filter menu by clicking on that menu option.
This chapter describes the advanced options available in the Activity GUI.

This chapter contains the following sections:

- **Advanced Filters**: Describes how to filter packets by system ID, zone ID, or site ID.
- **Pausing the Activity List**: Describes how to create an *Activity Pause* window and the *Activity Pause* window options.
- **Activity Details**: Describes how to view the detailed information for an activity.
Advanced Filters

The Activity GUI, by default, accepts activity from all connected systems, zones, sites, groups, radios and agencies. The sections below describe how to filter the activity.

Trunking Filters

If you wish to filter the Activity GUI based on Trunking Systems, click on the Advanced menu option of the Filter menu, then click on the Trunking Filters… menu option. This will load the Advanced Filters window.

The current state of any trunking filters is displayed in the menu bar. Clicking on this text will load the Advanced Filters window. If you have applied any filters in the Advanced Filters window, the menu bar will provide details on the types of active filters.

System Filter

This filter will allow the Activity GUI to be filtered by System, Zone and Site.

1. Click on the System tab.
2. Uncheck the nodes of the Systems, Zone and/or Sites that you wish to exclude. Filters are applied to the scrolling data as you check/uncheck nodes.
3. Click the OK button. This will return you to the Activity GUI.

![Advanced Filters - System Tab](image)

Figure 2.1 – Advanced Filters – System Tab

⚠️ This tree only contains system IDs, zone IDs and site IDs received by the Activity GUI. This window does not reference the GW3-TRBO Alias database for a list of these IDs.

ℹ️ For multisite systems, if activity contains a Site ID List and one of the sites in the Site ID List is marked as Allowed, Activity will show this activity. You can see an activity’s Site ID List via the Activity Details window. See the Activity Details section below.
**Group Filter**

This filter will allow the Activity GUI to be filtered by group.

1. Click on the **Groups** tab.
2. Click the **Filter Activity by Group** option.
3. Click the **Add** button to add one or more groups.
4. Click the **OK** button. This will apply your filter and return you to the Activity GUI.

![Advanced Filters – Groups Tab](image)

**Figure 2.2** – Advanced Filters – Groups Tab
Radio ID Filter
This filter will allow the Activity GUI to be filtered by radio ID.
1. Click on the Radio ID tab.
2. Click the **Filter Activity by Radio** option.
3. Click the **Add** button to add one or more radio IDs.
4. Click the **OK** button. This will apply your filter and return you to the Activity GUI.

![Figure 2.3 – Advanced Filters – Radio ID Tab](image)

Agencies Filter
This filter will allow the Activity GUI to be filtered by agencies.
1. Click on the Agencies tab.
2. Click the **Filter Activity by Agency** option.
3. Click the **Add** button to add one or more agencies.
4. Click the **OK** button. This will apply your filter and return you to the Activity GUI.

![Figure 2.4 – Advanced Filters – Agencies Tab](image)
Pausing the Activity List

You may wish to pause the activity list to view a snapshot of activity data or to make double-clicking on an activity easier. To pause the activity list, click the Pause menu button. This will open an Activity Pause window that contains the data in the activity list at the time of the pause.

![Activity Pause Window](image)

**Figure 2.5** – Activity Pause Window
Pause Window Options

Opacity (available in menu only)
Opacity measures how close a window is to solid (not transparent). You can adjust the opacity of an Activity Pause window (making it more transparent) to allow you to see real-time activity while viewing the Activity Pause window.

Print (available in menu and right-click)
Prints the Activity Pause window. This window will print in a landscape format (longer horizontally than vertically). You may need to adjust the column widths of the Activity Pause window to print the desired data.

Select All... (available in right-click only)
Contains the following options for selecting like activity in the Activity Pause window.

- Activities on the selected group: Selects all activities with the same Group as the topmost selected activity.
- Activities from the selected radio ID: Selects all activities with the same ID as the topmost selected activity.
- Activities of the selected type: Selects all activities with the same Description and Type as the topmost selected activity.
- Activities in the selected conversation: Selects all activities within the same conversation as the topmost selected activity. This generally involves packets that share a common Conversation Number or Call Index.
**Activity Details**

Each activity shown in the Activity GUI contains much more information than what is shown in the columns of the activity list. To view this additional information, double-click on the desired packet in either the main window or an Activity Pause window. This will show the Packet Information window, shown below.

![Packet Information Window](image)

**Figure 2.6** – Packet Information Window